
Accessibility in Microsoft® PhotoDraw™ 
2000 

White Paper

Published: October 1998



Accessibility in Microsoft® PhotoDraw™ 2000

Contents

Introduction...........................................................................................................1

Accessibility features in PhotoDraw 2000...................................................................3
Keyboard support for most features......................................................................3
Support of Windows Accessibility Options...............................................................3
ToolTips.............................................................................................................4
Microsoft Clip Gallery and HTML Help.....................................................................4

Planned improvements for future versions of PhotoDraw..............................................5
Microsoft Active Accessibility support of menus and toolbars.....................................5
Keyboard access to the workspace........................................................................5
Color selection....................................................................................................5
Consistent read-out of selection............................................................................6

Tell us what you think..............................................................................................6

How to make Microsoft PhotoDraw 2000 easier to view and access................................7
Use keyboard shortcuts.......................................................................................7
Choose pan and zoom options..............................................................................7
View pictures in high-contrast black and white........................................................8
Enlarge toolbar buttons.......................................................................................8

Choose pan and zoom options in Microsoft PhotoDraw 2000.........................................9
Zoom in and out by using the Pan and Zoom window...............................................9
Pan the workspace by using the Pan and Zoom window............................................9
Scroll and zoom by using the Microsoft IntelliMouse pointing device...........................9
Zoom to show a selected object..........................................................................10
Zoom to show the picture area............................................................................10
Zoom to show all objects in the picture and scratch areas.......................................10

Keyboard shortcuts in Microsoft PhotoDraw 2000......................................................11
Keys for deleting and copying objects..................................................................11
Keys for selecting objects...................................................................................11
Keys for working with pictures............................................................................12
Keys for working with menus..............................................................................12
Keys for working with toolbars............................................................................14
Keys for working in windows and dialog boxes.......................................................14
Keys for working in the Open and Save dialog boxes..............................................15
Keys for working in the text window.....................................................................16
Keys for modifying selected text objects...............................................................16

Keyboard-mouse combinations...............................................................................17
For drawing an AutoShape..................................................................................17
For drawing a line..............................................................................................17
For moving an object.........................................................................................17



Accessibility in Microsoft® PhotoDraw™ 2000

For moving a line..............................................................................................17
For resizing an object or picture..........................................................................17
For cropping a picture........................................................................................17
For rotating an object........................................................................................18
Keys for working with Help.................................................................................18
In the navigation pane.......................................................................................18
In the topic pane...............................................................................................18
Function keys...................................................................................................19
Keys for working with the picture list and object list...............................................19
Microsoft IntelliMouse support.............................................................................20
Keys for working with selected objects.................................................................20
 



 Accessibility in Microsoft PhotoDraw 
2000
White Paper 

Published: October 1998 

For the latest information, please see http://www.microsoft.com/office/  

Introduction
Microsoft® PhotoDraw™ business graphics software is a graphics application designed 
for business users in general and Microsoft Office users in particular. Similar to 
other Office products, PhotoDraw includes accessibility features that make 
reading text and viewing screen displays easier for people who are blind or have 
low vision. These accessiblity features also make working with objects, menus, 
toolbars, and workpanes easier for people with limited dexterity.

Use keyboard shortcuts   Many PhotoDraw features and commands are available 
directly from the keyboard.

Choose pan and zoom options   You can pan the workspace and change the 
zoom level of your picture on the screen.

Use Microsoft IntelliMouse™   If you use the Microsoft IntelliMouse or Microsoft 
IntelliMouse TrackBall pointing device, you can scroll, pan, and zoom directly 
from the mouse. For example, you can zoom in or out of the picture area by 
rotating the Intellimouse wheel forward or backward.

Enlarge toolbar buttons   You can make toolbar buttons larger so that they're 
easier to see and use.

View pictures in high-contrast black and white   You can use colors and fonts 
that are especially easy to view on display screens.

Use the built-in accessibility features of Microsoft Clip Gallery and HTML Help   
Microsoft Clip Gallery features keyboard support, screen reader support, and 
large clip previews; HTML Help features hyperlinks so that users can move more 
easily through topics. 

Note   If your system uses the Microsoft Windows® 95 operating system or 
later, you can set or change system accessibility options. For example, by 
turning on the Windows MouseKeys feature, you can use the numeric keypad to 
move the mouse pointer and to click, double-click, and drag. To set or change 
accessibility options, point to Settings on the Windows Start menu, and then 
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click Control Panel. Double-click Accessibility Options, click the tab you want,
and then select the options you want. For Help on an option, click the question 
mark button, and then click the option.

For more information
Download accessible documentation for Microsoft products (link to ASCII text 
version of manual)

Tell us what you think  
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Accessibility features in PhotoDraw 2000

Keyboard support for most features

Microsoft PhotoDraw 2000 includes keyboard access to all features, either via 
access keys or the TAB key, in order to set focus to controls and execute 
commands:

Tab order and navigation keys
When working in PhotoDraw workpanes and dialog boxes, press the TAB key to 
move from one control to another in a left-to-right and top-to-bottom direction. 
Pressing F6 or Shift+F6 moves the keyboard focus among the workpane, the 
picture area, and the picture list.

Each PhotoDraw menu, including the main menu and the visual menu, has been 
assigned access keys indicated as underlined letters. Press ALT+ the underlined 
access key to drop down menus and select commands from them.

Note   Access keys on workpanes will be added to future versions of PhotoDraw 
if it becomes a popular user request. Also, the Position Picture and Replace 
commands do not support keyboard interaction, but they do support MouseKeys.

Documentation of keyboard support in online Help
The keyboard interface for PhotoDraw is fully documented in online Help. You 
can display these Help topics at any time by choosing Keyboard Shortcuts 
from the Help menu, or by pressing F1 to open Help and then searching for 
these topics.

Customization of keys and colors
PhotoDraw lets you customize the following options:

 To change the nudge amount in the workspace when the arrow keys are used
to move the selected object, or to change the function of the Intellimouse 
wheel, choose Options from the Tools menu, and then change the Mouse 
and keyboard settings on the General tab of the Options dialog box.

 To change the color of the view finder in the Pan and Zoom window, choose
Options from the Tools menu, and then change the Pan and Zoom view 
finder color on the View tab of the Options dialog box.

 To change the color of the picture area, choose Picture Setup from the File 
menu, and then change the Color setting on the Active Picture tab for the 
open picture, or on the New Picture Defaults tab for all future pictures.

 To show shortcut keys in tooltips, choose Options from the Tools menu, and
then set the Show shortcut keys in ScreenTips option on the Toolbars 
tab of the Options dialog box.

Support of Windows Accessibility Options

By default, PhotoDraw 2000 uses the same display settings as Office 97 and Office 
2000. You can change the default display settings by choosing options in the 
Windows Control Panel:
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 To enlarge the font, select the Display icon, and then choose the Large 
Fonts setting on the Settings tab of the Display Properties dialog box.

 To change the desktop color scheme, select the Display icon, and then 
choose one of the High Contrast settings on the Appearance tab of the 
Display Properties dialog box.

 To enlarge desktop icons, select the Display icon, and then select the Use 
large icons option on the Plus! tab of the Display Properties dialog box.

 To set any of the system-wide accessibility options, select the Accessibility 
Options icon, and then choose the desired options in the Accessibility 
Properties dialog box.

ToolTips

ToolTips appear on most PhotoDraw graphical controls and unlabeled controls. For 
example, when the pointer hovers over a picture button or any unlabeled galleries, 
a ToolTip appears. Context-sensitive Help can also be displayed for the majority of 
controls by tabbing to a control and then pressing SHIFT+F10 or CTRL+SHIFT+F10.

Note   You can increase the font size in ToolTips to make them easier to read by 
following these steps:
1. In the Windows Control Panel, select the Display icon.
2. On the Appearance tab of the Display Properties dialog box, select 

ToolTip in the Item list.
3. Increase the font size in the Size list, or select a different color in the Color 

list.

Microsoft Clip Gallery and HTML Help

Improvements to Clip Gallery and the introduction of HTML Help in Microsoft 
PhotoDraw as well as Office 2000 offer the following features:

 Search support in Clip Gallery   Improved natural language query and the 
new Find Similar feature increase access to Clip Gallery with a reduced 
number of keystrokes.

 Keyboard support for Clip Gallery   Because features in Clip Gallery can be
accessed via the keyboard, they are more accessible to users who have 
difficulty using the mouse.

 Clip Gallery screen-reader support   In PhotoDraw 2000, the Clip Gallery 
allows screen readers to read ToolTips, clip captions and other text.

 Large clip previews in Clip Gallery   Increased size of large clip previews 
makes clip viewing easier for those with low vision.

 HTML Help   In PhotoDraw 2000 users can use hyperlinks to move 
through Help, which makes it more navigable for those who are blind or
have low vision.
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Planned improvements for future versions of 
PhotoDraw

Microsoft Active Accessibility support of menus and toolbars

By supporting Microsoft Active Accessibility™ programming interfaces, PhotoDraw 
would give third-party vendors access to menus and toolbars (third-party access 
would  include the ability to navigate to a toolbar and its individual controls, move a
toolbar, and get the name of a control when it has keyboard focus).

In addition, third party vendors would also be able to access these controls:

 Visual menu
 Picture list
 Object list
 Workspace (picture area and scratch area)
 Pan and Zoom window
 Floating toolbars
 Fly-out menus in toolbars (shapes, arrows, curves, order, flip/rotate, fill 

color, line color, line width, line style)
 Galleries and color boxes in workpanes 

Keyboard access to the workspace

Scrolling the workspace
In PhotoDraw 2000, the picture area and scratch area can be scrolled only by 
clicking inside the scrollbars that border the workspace. The ability to page up and 
down in the workspace will be featured in the next-version.

Manipulating and replacing objects
In PhotoDraw 2000, you must work with a mouse to use the Position 
Picture and Replace commands, to move the pictures guides, and to 
move or resize the shapes used to crop, cut out, or erase part of an 
object. Future versions of PhotoDraw will include keyboard support for 
these tasks.

Reordering objects in the object list
While PhotoDraw 2000 users can use keyboard shortcuts to select 
multiple objects in the object list, they must use a mouse to change an 
object's front-to-back order.

Color selection

The Eyedropper tool that appears in several PhotoDraw 2000 workpanes lets users 
change the active color by clicking anywhere on the desktop. In future versions of 
PhotoDraw, users will be able to position the Eyedropper by using the arrows keys.
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Note: While the True Color matrix requires the use of the mouse to select a
color, the sliders and text boxes on the True Color tab of the More Colors 
dialog box allow you to use the keyboard to specify a color.

Consistent read-out of selection

Many but not all controls in PhotoDraw 2000 use hidden text labels to accurately 
identify the control that has the keyboard focus to accessibility aids. The 
implementation of these labels will be reviewed for accuracy and extended to all 
controls in future versions.

In addition, future versions of PhotoDraw will broadcast changes in the selection 
focus, error messages, and soft alerts. 

Tell us what you think
Microsoft is dedicated to providing more support for people with 
disabilities. To send us suggestions about what we can do to make 
PhotoDraw more accessible, click WRITE US on the Microsoft toolbar, 
then click Send in a wish.
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How to make Microsoft PhotoDraw 2000 easier to 
view and access

Use keyboard shortcuts

PhotoDraw provides keyboard support for most common tasks. Read more about:

 Keys for deleting and copying objects  

 Keys for selecting objects  

 Keys for working with pictures  

 Keys for working with menus  

 Keys for working with toolbars  

 Keys for working in windows and dialog boxes  

 Keys for working in the Open and Save dialog boxes  

 Keys for working in the text window  

 Keys for modifying selected text objects  

 Keyboard-mouse combinations  

 Keys for working with Help  

 Function keys  

 Keys for working with the picture list and object list  

 Microsoft IntelliMouse support  

 Keys for working with selected objects  

Choose pan and zoom options

When you need to make a precise selection (for example, when you fix a small 
scratch in a photograph or cut out an area in an object), it’s often best to zoom in 
on the area you’re working on. To quickly change the view, click the arrow next to 
the Zoom box on the toolbar, and then select a zoom percentage. You can also use 
the Pan and Zoom window and the commands on the View menu to:

 Zoom in and out by using the Pan and Zoom window  

 Pan the workspace by using the Pan and Zoom window  

 Scroll and zoom by using the Microsoft IntelliMouse pointing device  

 Zoom to show a selected object  

 Zoom to show the picture area  
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 Zoom to show all objects in the picture and scratch areas  

View pictures in high-contrast black and white

High contrast is an accessibility feature that uses colors and fonts 
designed for easy screen reading.

1. On the Windows Start menu, point to Settings, and then click Control 
Panel.

2. Double-click the Accessibility Options icon.
3. On the Display tab, click Use High Contrast.
4. Click OK.

The PhotoDraw workspace, menus, and toolbars appear in high-contrast black and 
white.

Notes
 High contrast is a screen-only setting; it does not apply to the printed 

picture.

 Windows NT® operating system version 4.0 does not support picture 
display in high-contrast black and white.

Enlarge toolbar buttons

On the Tools menu, click Options, and then click the Toolbars tab.
Select the Large Icons box.

Notes

 When you select or clear the Large Icons box, the setting affects all 
Microsoft Office programs.

 When you select or clear the Large Icons box, this setting does not 
affect icons that appear in online Help.
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Choose pan and zoom options in Microsoft 
PhotoDraw 2000

Zoom in and out by using the Pan and Zoom window

1. On the View menu, make sure Pan and Zoom is checked.
2. In the Pan and Zoom window, do one of the following:
 To zoom in on a picture, drag the Zoom slider toward the top.

 To zoom out, drag the Zoom slider toward the bottom.

Tip   If you're using the Microsoft IntelliMouse pointing device, you can use it to 
zoom in or out of the workspace.

Pan the workspace by using the Pan and Zoom window

1. On the View menu, make sure Pan and Zoom is checked.
2. In the Pan and Zoom window, drag the view finder to the area you want to 

see.

Tip   If you're using the Microsoft IntelliMouse pointing device, you can use it to pan
the workspace.

Scroll and zoom by using the Microsoft IntelliMouse pointing 
device

You can move around and zoom in on the workspace by using the Microsoft 
IntelliMouse pointing device. For information about changing options and viewing 
troubleshooting tips for the Microsoft IntelliMouse, see the IntelliPoint Online User's 
Guide. (In most cases, you can find the User's Guide by clicking the Windows Start 
button, pointing to Programs, and then pointing to Microsoft Input Devices.)

To Do this

Pan the workspace in any 
direction.

Hold down the wheel button and drag the pointer away from the 
origin mark in the direction you want to scroll. To speed up 
scrolling, drag away from the origin mark; to slow down scrolling, 
drag toward the origin mark.

Zoom in or out on the 
workspace.

Rotate the IntelliMouse wheel forward or back. 

Tips
 By default, rotating the wheel button in the workspace zooms instead of 

scrolls. If you use the Microsoft IntelliMouse pointing device to scroll 
more often than you use it to zoom, you can set the wheel button to 
scroll by default. On the Tools menu, click Options, click the General 
tab, and then click Scroll under Mouse and keyboard.

 You can press the CTRL key while rotating the wheel to quickly switch 
between zooming and panning.
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Zoom to show a selected object

1. On the workspace or in the object list, select the object you want to zoom to.

2. On the toolbar, click the arrow next to the Zoom box.

3. Click Selection.

Zoom to show the picture area

 On the toolbar, click the arrow next to the Zoom box.

 Click Fit Picture Area.

Zoom to show all objects in the picture and scratch areas

 On the toolbar, click the arrow next to the Zoom box.

 Click Fit All.
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Keyboard shortcuts in Microsoft PhotoDraw 2000

Keys for deleting and copying objects

Press To
DELETE Delete the selected object

CTRL+X Cut the selected object

CTRL+C Copy the selected object

CTRL+V Paste the cut or copied object

CTRL+Z Undo the last action

Keys for selecting objects

Press To select
F6 to activate the workspace, then TAB (to move backward 
in the stack) or SHIFT+TAB (to move forward in the stack) 
until the object you want is selected

An object in the workspace other than 
the one selected 

CTRL+TAB Next toolbar

CTRL+SHIFT+TAB Previous toolbar

CTRL+A Select all the objects in the picture

* CTRL+DOWN ARROW Move selected object backward in the 
picture

* CTRL+UP ARROW Move selected object forward in the 
picture

* CTRL+G Group the selected objects

*denotes keys that are specific to PhotoDraw 2000.
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Keys for working with pictures

Press To
CTRL+N Create a new picture

CTRL+D Make a copy of the selected object

CTRL+O Open a picture

CTRL+W Close a picture

CTRL+P Print a picture

CTRL+S Save a picture

ALT+F4 Quit PhotoDraw

CTRL+Z Undo a completed action or cancel an action in progress

CTRL+Y Redo or repeat an action

F6 Switch to the next pane (clockwise)

SHIFT+F6 Switch to the previous pane (counterclockwise)

ALT+ENTER Display the properties of the selected picture

* SPACEBAR Hide focus outline, resize handles, and picture guides

RIGHT ARROW or LEFT ARROW Nudge the picture or object that is selected in the workspace 
one unit to the right or left

UP ARROW or DOWN ARROW Nudge the picture or object that is selected in the workspace 
one unit up or down

SHIFT+RIGHT ARROW or LEFT 
ARROW

Nudge the picture or object that is selected in the workspace 
one grid to the right or left

SHIFT+UP ARROW or DOWN ARROW Nudge the picture or object that is selected in the workspace 
one grid up or down

* PLUS SIGN (+ on numeric 
keypad)

Zoom in one level

* MINUS SIGN (- on numeric 
keypad)

Zoom out one level

* denotes keys that are specific to PhotoDraw 2000.

Keys for working with menus

You can choose any menu command by using the keyboard. To do this, press ALT, 
followed by the letter underlined in the menu name, and then press the letter 
underlined in the command name. For example, to duplicate a selected object, press
ALT+E, and then press D.

Press To
SHIFT+F10 Display a shortcut menu that shows a list of commands relevant to 

the selected object

ALT+SPACEBAR Display the program Control menu

DOWN ARROW or UP ARROW Select the next or previous menu command

LEFT ARROW or RIGHT ARROW Select the menu to the left or right, or switch between a submenu 
and its main menu

SHIFT+F10 Display a pop-up menu
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Keys for working with toolbars

Press To
F10 Activate the menu bar 

CTRL+TAB Select the next toolbar

CTRL+SHIFT+TAB Select the previous toolbar

TAB or SHIFT+TAB Select the next or previous button or menu on the active toolbar

ENTER Open the selected menu; perform the action assigned to the selected button; 
enter text in the selected text box; select an option in a list box or on a menu

ENTER Enter text in the selected text box

ENTER Enter numbers in the selected box

Arrow keys Move through options in a list box or on a menu

ALT Activate visible floater menus 

* ALT+F or 
ALT+F+F

Carry out Finish command on floater menus

* denotes keys that are specific to PhotoDraw 2000.

Keys for working in windows and dialog boxes

Press In a window to
ALT+TAB Switch to the next program

ALT+SHIFT+TAB Switch to the previous program

CTRL+ESC Display the Windows Start menu

CTRL+W Close the active picture window

CTRL+F5 Restore the active picture window 

CTRL+F6 Switch to the next picture window

CTRL+SHIFT+F6 Switch to the previous picture window 

F6 Switch to the next window pane in the clockwise direction

SHIFT+F6 Switch to the next window pane in the counterclockwise 
direction

ALT+0 Select the folder list in the Open or Save As dialog box (File 
menu)

The arrow keys Select a folder in the Open or Save As dialog box (File menu)

ALT+number (1 for the leftmost 
button, 2 for the next, and so on)

Select a toolbar button in the Open or Save As dialog box 
(File menu)

SHIFT +CTRL+F12 Carry out the Print command (File menu)

CTRL+F12 Carry out the Open command (File menu)

F12 Carry out the Save As command (File menu)

CTRL+TAB Switch to the next toolbar (including the visual menu) 

CTRL+SHIFT+TAB Switch to the previous toolbar (including the visual menu)

F5 Update the files visible in the Open or Save As dialog box 
(File menu)
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Press In a dialog box to
CTRL+TAB Switch to the next tab in a dialog box

CTRL+SHIFT+TAB Switch to the previous tab in a dialog box

The TAB key Move to the next option or option group

SHIFT+TAB Move to the previous option or option group

The arrow keys Move between options in a selected drop-down list box or 
between some options in a group of options 

SPACEBAR Perform the action assigned to the selected button; select or 
clear the check box

The first letter of the option name Move to an option in a selected drop-down list box

ALT+the letter underlined in the 
option name

Select an option; select or clear a check box

ALT+DOWN ARROW Open a selected drop-down list box

ENTER Perform the action assigned to a default button in a dialog box

Press In a text box to
HOME Move to the beginning of the entry

END Move to the end of the entry

LEFT ARROW Move one character to the left

RIGHT ARROW Move one character to the right

CTRL+LEFT ARROW Move one word to the left

CTRL+RIGHT ARROW Move one word to the right

SHIFT+HOME Select from the insertion point to the beginning of the entry

SHIFT+END Select from the insertion point to the end of the entry

SHIFT+LEFT ARROW Select or cancel the selection one character to the left

SHIFT+RIGHT ARROW Select or cancel the selection one character to the right 

CTRL+SHIFT+LEFT ARROW Select or cancel the selection one word to the left

CTRL+SHIFT+RIGHT ARROW Select or cancel the selection one word to the right

TAB Move to next control option

SHIFT+TAB Move to previous control option

F6  or SHIFT+F6 Send focus to the workpane

Keys for working in the Open and Save dialog boxes

Press To
ALT+0 Select the folder list in the Open or Save dialog box (File menu)

ALT+1 Go to the previous folder

ALT+2 Open your World Wide Web search page



Accessibility in Microsoft® PhotoDraw™ 2000 14

Keys for working in the text window

Press To 
LEFT ARROW Move one character to the left

RIGHT ARROW Move one character to the right

UP ARROW Move one line up

DOWN ARROW Move one line down

CTRL+LEFT ARROW Move one word to the left

CTRL+RIGHT ARROW Move one word to the right

END Move to the end of a line

HOME Move to the beginning of a line

CTRL+END Move to the end of a text box

CTRL+HOME Move to the beginning of a text box

BACKSPACE Delete one character to the left in the text window

CTRL+BACKSPACE Delete one word to the left in the text window

DELETE Delete one character to the right in the text window

SHIFT+RIGHT ARROW Select one character to the right

SHIFT+LEFT ARROW Select one character to the left

CTRL+SHIFT+RIGHT 
ARROW

Move to the end of a word

CTRL+SHIFT+LEFT 
ARROW

Move to the beginning of a word

SHIFT+UP ARROW Move one line up

SHIFT+DOWN ARROW Move one line down

Keys for modifying selected text objects

Press To
CTRL+B Apply or remove bold formatting

CTRL+I Apply italic formatting

CTRL+E Center lines of text within a text object

CTRL+L Left-align text within a text object

CTRL+R Right-align text within a text object
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Keyboard-mouse combinations

For drawing an AutoShape

To Hold down
* Draw a perfect square, circle, or other shape that can be
inscribed within a square 

SHIFT and drag

* Draw an AutoShape from its center outward CTRL and drag

* Temporarily turn the snap-to-grid feature on or off as 
you draw

ALT and drag

* denotes combinations that are specific to PhotoDraw 2000.

For drawing a line

To Hold down
* Draw a line at an angle that's a multiple of 15 degrees SHIFT and drag

* Draw a line from its center outward CTRL and drag

* denotes combinations that are specific to PhotoDraw 2000.

For moving an object

To Hold down
Move an object horizontally or vertically SHIFT and drag

Copy an object CTRL and drag

For moving a line

To Hold down
Lengthen or shorten a line while maintaining its orientation SHIFT and drag the end point

Reposition a line about its center CTRL and drag the end point

For resizing an object or picture

To Hold down
* Skew an object CTRL+ALT and drag the resize handle

Resize the object or picture from its center outward CTRL and drag any resize handle

* denotes combinations that are specific to PhotoDraw 2000.

For cropping a picture

On the Cut & Crop menu, click Crop, and then click a crop shape in the workpane.
To Hold down

* Move the crop shape horizontally or vertically SHIFT and drag

* Define the crop shape area from the center outward CTRL and drag any cropping handle

* denotes combinations that are specific to PhotoDraw 2000.
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For rotating an object

Drag the rotate handle on an object.
To rotate an object Hold down

* In 15-degree increments SHIFT and drag the rotate handle

* denotes combinations that are specific to PhotoDraw 2000.

Keys for working with Help

Press To

ALT+SPACEBAR Display the program Control menu

F5 Refresh the Help topic

In the navigation pane

Press To
CTRL+TAB Switch to the next tab

ALT+C Switch to the Contents tab

ALT+A Switch to the Answer Wizard tab

ALT+I Switch to the Index tab

ENTER Open a selected book or Help

DOWN ARROW Select the next book or Help topic

UP ARROW Select the previous book or Help topic

In the topic pane

Press To
ALT+RIGHT ARROW Go to the next Help topic

ALT+LEFT ARROW Go to the previous Help topic

END Move to the end of a Help topic

CTRL+P Print the active Help topic

CTRL+A Select the entire Help topic

CTRL+C Copy the selected items to the Clipboard
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Function keys

Press To
F1 Display Help

SHIFT+F1 Display What's This?

F2 Show or hide the workspace

SHIFT+F2 Show or hide the workspace

F3 Show or hide the picture list

CTRL+F4 Close the active window

ALT+F4 Quit PhotoDraw

ALT+SHIFT+F4 Quit PhotoDraw

F6 Move clockwise to the next pane

SHIFT+F6 Move counterclockwise to the previous pane

F9 Activate the picture list

F10 Activate the menu bar

* F11 Carry out Fit to Picture Area command (View menu)

CTRL+F12 Carry out Open command (File menu)

SHIFT+CTRL+F12 Carry out Print command (File menu)

F12 or SHIFT F12 Carry out Save As command (File menu)

SHIFT+F10 Activate the shortcut menu

CTRL+SHIFT+F10 Activate the shortcut menu

* denotes keys that are specific to PhotoDraw 2000.

Keys for working with the picture list and object list

Press To
* F9 Activate the picture list

F6 Move clockwise to the next pane

SHIFT F6 Move counterclockwise to the previous pane 

* F3 Show or hide picture list

UP ARROW Send the focus to the next picture up in the picture list, or send the 
focus to the next object up in the object list

DOWN ARROW Send the focus to the next picture down in the picture list, or send the 
focus to the next object down in the object list

SPACE BAR Select an object or picture

LEFT ARROW Move between the picture list and object list

LEFT ARROW ( twice) Close the object list

RIGHT ARROW Open the object list for the picture that has the focus in the picture list

* denotes keys that are specific to PhotoDraw 2000.
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Microsoft IntelliMouse support

Action To
Rotate the wheel forward Zoom in on the workspace

Rotate the wheel backward Zoom out on the workspace

Hold down the wheel while moving the mouse 
forward

Scroll up the workspace 

Hold down the wheel while moving the mouse 
backward

Scroll down the workspace

Click the wheel while moving the mouse Pan the workspace in all directions

Keys for working with selected objects

Action To
*CTRL+DOWN ARROW Move a selected object backward in the picture

* CTRL+UP ARROW Move a selected object forward in the picture

* CTRL+G Group the selected objects

* denotes keys that are specific to PhotoDraw 2000.

For more information: http://www.microsoft.com/office/ 

   

http://www.microsoft.com/office/
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